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GUIDE FOR TEMPLATE CREATION 
This document will assist in prepping your artwork fi le for template creation for eventual placement on your brand portal. 
If providing a fi le that is not InDesign or Illustrator – although similar rules apply – the template creation process will 
require more time.

The following are fi le setup details specifi c to products that allow end-users to customize via Brand Portal tools. 

 Here are 6 main considerations when building artwork fi les for template conversion:
  1.  Fonts

  2. Colors

  3. Text Frames and Styles

  4. Layers

  5. Defi ning Customization

   a. Variable Types & Functionality

   b. Settings

   c. Database

  6. Packaging File for Hand-O� 

 For demonstration we will review best practices when setting up a basic 2-sided postcard, as shown.

Join our [beer rewards club] today

You’re
 Invited
[Name]

Sign up today

• [A Free Beer Club Growler – fill up anytime for $10]
• [Advanced email notice of new beers being released]
• [Additional $1 Off Beers During Happy Hour]

• [A Free 12 oz Beer on Your Birthday]
• [10% Off Apparel and Merchandise]
• [Exclusive Beer Club Member Events]

Go to strausbrewhaus.com and print your 
membership card to pick up your free growler. 
Find your nearest location in the map below:

Sample A. Sample
123 Main Street
Anytown, US 12345

Join our beer rewards club for [$25] 
And receive [special benefits]

[1000 Uniek Drive, Waunakee, WI 53597]

Uniek Dr

Burger Ave

Barley Blvd

Craft Blvd

Hops Rd

Fry Rd
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STEP 1: FONTS
Since templates are cross-platform browser-based documents, ensure you are building with OpenType fonts. 

 How to check:
 1. Find the Type Menu at the top left of the InDesign or Illustrator window screen

  

 2. Click on the “Find/Replace Font” button within the Type Menu

 3. With the font name selected, click on the “More Info” button in the type fi nder panel

  

  
  Ensure font types listed are O = OpenType

If non-OpenType fonts are used in background or non-customized areas, you can convert the text to outlines within the document to 
avoid acquiring OpenType fonts. 

Customizable font areas must remain as live text and therefore must be OpenType or TrueType.

If using cloud fonts, note they will not package as expected. It is still possible to collect the font for template creation: Suttle Straus 
will collect these fonts.

  

  

OpenType



1000 Uniek Drive  |  Waunakee, Wisconsin 53597  |  608 849 1000  |  suttle-straus.com

STEP 2: COLORS
Is it 4-color? Are there spot colors? Ensure the colors of your document match how the fi le will print. Use the Swatches 
palette and/or the Ink Manager to control this. Select all unused swatches and delete.

 How to check:
 1. Find the Window Menu at the top left InDesign or Illustrator window screen

  

 2. Click on the “Color” button within the Window Menu and select “Swatches”

 3. In the “Swatches” panel ensure the color(s) of your document are set to the correct print process.
  

  

Note: After implementation and color guidance, the provided fi les for template creation or updates will not be checked nor color 
corrected to match your brand standards guide. During setup your document will be converted to 4-color process, if necessary or 
if not already done.
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STEP 3: TEXT FRAMES AND STYLES IN INDESIGN
The following are some best practices for working with text in artwork for template conversion.

When setting up customized text with di� erent style and formats, be sure the content is created in separate text frames.

Text Styles -  Most InDesign character and paragraph style settings will translate into template creation, 
   however having presets can be very helpful to the creation process. 

 Additionally not all styles are supported. The following are common unsupported styles:
· Font sizes above 720 point
· Custom kerning between characters
· Gradients within customizable text (text should be solid)
· Custom text with outline and clear fi ll (actual outlined font must be used)
· Artifi cial skewing of text to create the look of italics (actual italic font must be used)
· Drop Caps
· Stacked Vertical 1-column lettering  

STEP 4: LAYERS IN INDESIGN
Within InDesign or Illustrator use brackets, layers and default text to defi ne customizable content within the document.

Customizable text can be denoted with brackets. We do not recommend the use of default copy in variable fi elds - if you plan to 
include on the templates sample copy in a variable fi eld, please put it inside the brackets.   

 Refer to example below:
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Join our [beer rewards club] today

You’re
Invited
[Name]

STEP 2: LAYERS
Define 2 layers – Custom and Background. Place all customizable elements onto the Custom layer and all other elements 
onto the Background layer. For customized paragraphs, move the entire text block to the Custom layer even if only one 
word ultimately will be editable by the end user.

Customizable text can be denoted with brackets. Place the default text you would like used within these brackets. 
Default text is defined as the “sample” text within the template and is what the end user would see as their 
initial view prior to making any edits to the template in the brand portal.

Custom and Background 
layers defined

Custom layer off, 
leaving only the Background

Hiding the visibility 
of the Variable layer 

only the Background 
content is visible
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Join our [beer rewards club] today

You’re
Invited
[Name]

STEP 2: LAYERS
Define 2 layers – Custom and Background. Place all customizable elements onto the Custom layer and all other elements 
onto the Background layer. For customized paragraphs, move the entire text block to the Custom layer even if only one 
word ultimately will be editable by the end user.

Customizable text can be denoted with brackets. Place the default text you would like used within these brackets. 
Default text is defined as the “sample” text within the template and is what the end user would see as their 
initial view prior to making any edits to the template in the brand portal.

Custom and Background 
layers defined

Custom layer off, 
leaving only the Background

Brackets around 
custom text

· Custom text stays  
in-line with 

background text

· Custom text is on 
separate 

“Variable” layer

All content and 
images are 

designated to
 “Background” & 
“Variable” layers
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STEP 5: DEFINING CUSTOMIZATION
For all customized products, provide a PDF to visualize your fi nal intent. Use the comments panel in Adobe Acrobat to identify the 
expected functionality of the document. Use as much detail as possible to clearly communicate each customizable element.

 Refer to the example below:
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INDESIGN DOCUMENT SETUP GUIDE 
This document will assist in prepping an Adobe InDesign file for eventual placement on your brand portal. If providing 
an Adobe Illustrator file these instructions closely mirror the process needed for that file type. If providing a file that 
is not InDesign or Illustrator, although similar rules apply, the template creation process will require more time. 
These instructions are specific to products allowing end users to customize via the Media Builder tools. 

THERE ARE 5 MAIN CONSIDERATIONS WHEN BUILDING THIS FILE:
1. Fonts

2. Layers

3. Colors

4. Custom field definition

5. Packaging File

For demonstration we will review best practices when setting up a basic 2-sided postcard, as shown.

Join our [beer rewards club] today

You’re
Invited
[Name]

Sign up today

• [A Free Beer Club Growler – fill up anytime for $10]
• [Advanced email notice of new beers being released]
• [Additional $1 Off Beers During Happy Hour]

• [A Free 12 oz Beer on Your Birthday]
• [10% Off Apparel and Merchandise]
• [Exclusive Beer Club Member Events]

Go to strausbrewhaus.com and print your 
membership card to pick up your free growler. 
Find your nearest location in the map below:

Sample A. Sample
123 Main Street
Anytown, US 12345

Join our beer rewards club for [$25] 
And receive [special benefits]

[1000 Uniek Drive, Waunakee, WI 53597]

Uniek Dr

Burger Ave

Barley Blvd

Craft Blvd

Hops Rd

Fry Rd
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Join our [beer rewards club] today

You’re
Invited
[Name]

STEP 2: LAYERS
Define 2 layers – Custom and Background. Place all customizable elements onto the Custom layer and all other elements 
onto the Background layer. For customized paragraphs, move the entire text block to the Custom layer even if only one 
word ultimately will be editable by the end user.

Customizable text can be denoted with brackets. Place the default text you would like used within these brackets. 
Default text is defined as the “sample” text within the template and is what the end user would see as their 
initial view prior to making any edits to the template in the brand portal.

Custom and Background 
layers defined

Custom layer off, 
leaving only the Background

• [A Free Beer Club Growler – fill up anytime for $10]
• [Advanced email notice of new beers being released]
• [Additional $1 Off Beers During Happy Hour]

You’re
Invited
[Name]

Join our [beer rewards club] today

Join our beer rewards club for [$25] 
And receive [special benefits]
• [A Free 12 oz Beer on Your Birthday]
• [10% Off Apparel and Merchandise]
• [Exclusive Beer Club Member Events]

[1000 Uniek Drive, Waunakee, WI 53597]

Name fi eld “ Postcard Version” 
Background image changes based on 
version. Create a drop down list with 
Beer Flight, Three Beers, and Couple  
as options. Set the Three Beers as a 
default version.

Name fi eld “Recipient Name” The 
text fi eld should shrink to fi t. “You’re 
invited” should also shrink to fi t with 
the “Recipient Name.”

Allow for the message to be 
customizable. The text fi eld should 
auto-fi t, long lines of text should fi t 
to a single line, without crowding the 
social icons. Set “Beer Rewards Club” 
as the default.

Name fi eld “Reward O� er”. 
This fi eld is auto-populated from 
Location Manager, allow text to 
be editable.

Allow for the message to be custom-
izable. The text fi eld should auto-fi t, 
long lines of text should fi t to a single 
line. Set “ Special Benefi ts” as the 
default.

Each Bullet Point is an item on a drop 
down list. There should be a total of 6 
drop down lists. The drop downs also 
include a selection for other, with the 
option for the user to enter the text. 
The user gets the option to choose 
the number of Bullet Point o� ers they 
want to list. At minimum they will get 2 
bullets points. The bullet points should 
read across. Example: Bullet 2 is in the 
second column across from Bullet 1 

The Return address at the top of 
the mailing panel is auto-populated 
from Location Manager.  (Street 
Address, Suite/Unit Address, City, 
State, Zip) Longer addresses will wrap 
to two lines.

The Location Map is auto-populated 
from Location Manager.



1000 Uniek Drive  |  Waunakee, Wisconsin 53597  |  608 849 1000  |  suttle-straus.com

STEP 5: DEFINING CUSTOMIZATION: CONTINUED
 A. Variable Types & Functionality: 
 The following are programed variable options that apply a function to each text frame.

Single Line Text Field: Formatted Text:

   Multiple Line Text Field:

   Text frames within templates can behave in a variety of ways. The following are common confi gurative 
   options for text frames:

· Resize text frame based on amount of text entered (see “Text Frame Sizing” below)
· Resize text based on amount of text entered (see “Copy Fitting” below)
· Alignment of text · Columns
· Wrap · Character spacing
· Style · Text on a path

Text Frame Sizing -  As a user enters more copy, text frames can increase or decrease in size while 
    keeping the original text size preserved.

    Depending on the type of template, there may be a desire to control how the 
    text frame is positioned as it resizes. 

The following options can be applied to text frames:
· Grow in one direction (ex: down)
· Grow in multiple directions (ex: down and right)
· Limited (ex: limited to 1” down to avoid running into other elements on the template)
· Anchored to other objects impacting their positioning  

   Formatting and 
   character limits -  Some forced formatting can be applied to customizable text to control user 
    entry and enforce brand standards.

The following are common supported formatting function:
·  Phone numbers (XXX-XXX-XXXX or XXX.XXX.XXXX)
· Customized auto prefi x or su�  x (If the fax fi eld is completed, then the prefi x of FAX 

     appears on the template; if it is left blank, then FAX does not appear on the template.)
· Text limits (Using two characters for a “state” fi eld)
· Force all characters to uppercase or lowercase
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STEP 5: DEFINING CUSTOMIZATION: CONTINUED
Copy Fitting - A way to adjust font sizing based on the amount of text added within a text frame.

   When copy fi tting is used, the size of the text frame remains the same.

   Copy fi tting can accomplish the following:
· Incrementally decrease font size (as more text is added within a defi ned text frame)
· Incrementally increase font size (as text is removed - generally, this is less desirable)

   Depending on the template, there may be a need to control the fl exibility of copy fi tting.

The following options can be applied to copy fi tting:
· Defi ne a maximum number of lines (ex: setting a maximum of 3 lines, limiting the

    amount of content or enforcing a font-size reduction)
· Set a minimum font-size reduction (ex: if standard font was 12 pt and you did not want

    to allow shrinking below 6 pt, a 50% reduction limit can be applied)
· Set a minimum font-size enlargement (ex: if standard font was 12 pt and you did 

    not want to allow it above 24 pt, a 200% enlargement limit can be applied)

Number:  Barcode/QR Code:

   Color:

Button Bar: Checkbox:
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STEP 5: DEFINING CUSTOMIZATION: CONTINUED
Date:

   

  Date Display -  A force-formating function can be applied to control the style format 
   (ex. Month Day, Year or XX/XX/XXXX)

  Image:

  

Image Frame
  Options -  Images used as part of a customizable fi eld can have one of the following 
   placement functionality applied to the frame.

Stretch - Image will fi t-to-frame with no constraints on proportion. This can result in 
   distorted images. Therefore, it is not recommended.

Proportional Fit - Image will enlarge/reduce until either width or height fi lls the frame. 
   Note in this case, however, one dimension will fall short unless the image’s aspect ratio 
   is the same as the frame.

  



1000 Uniek Drive  |  Waunakee, Wisconsin 53597  |  608 849 1000  |  suttle-straus.com

STEP 5: DEFINING CUSTOMIZATION: CONTINUED
Manual - Image scale, size, position and rotation all are set manually in Media Builder. 

   You may opt to have image settings visible to the end user or hidden.

Proportional, Outside - Image will enlarge/reduce to fi t the lesser of width or height. 
   This is similar to proportional fi t, but some image clipping will occur as one dimension will 
   extend beyond the frame when the other dimension fi ts within the frame.

Image size & 
  format -  For images used as part of a customizable fi eld in your document, it is preferred they 
   are placed at 100% scale. Oversized images will slow the end-user experience for 
   template load.

The following are other considerations to make:
· Acceptable Vector Image File Formats (.eps, ai, pdf & .svg)
· Acceptable Raster Image File Formats (.pdf, .psd, .ti� , .tif, .jpg, jpeg, .png or .eps)
· Please remove all Photoshop alpha channels.
· Mix of tall and wide images placed into a wide frame will result in image clipping or 

    unwanted white space (ensure the aspect ratio is similar for all images, 
See Image Frame Options Above)

Calculated Field:  List:
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STEP 5: DEFINING CUSTOMIZATION: CONTINUED
B. Settings:

 The following settings can be used to help determine the user experience desired for each variable.

VARIABLE TYPES

SETTINGS Single 
Line

Mult. 
Lines

Formatted Calculated Image Number Checkbox Date List Button
Barcode/
QR Code

Required 
Content • • • • • •

Non-Required 
Content • • • • • • • • • •

Auto-
populated 

by Data Source
• • • • • • • •

Non-
editable • • • • • • • •

Free-edit • • • • • •

Default 
Value • • • • • • • • • •

No-default 
Value • • • • • • • • • •

Multiple 
Selection •

Single 
Selection • • •

Upload 
Only •

Upload 
& Selection 

(Re-use)
•

Upload & 
Selection 

Open Directory
•

Mathematical 
Calculations • •

Styles & 
Content Change • • • •

Date Selection 
w/ X day in 
Past/Future

•

Element 
Visibility • • •

Static Code 
Value •

Custom Code 
Value •
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STEP 5: DEFINING CUSTOMIZATION: CONTINUED
  C. Database
  If your templates are expected to auto-populate with database values, refer to the following options to
  determine how the data pumps through. The following are common data source options to utilize.

· CSV Datasource Embedded · Custom CSV Datasource Upload
· Import from User Profi le · Import from Location Manager

  User Profile Account Information:

   My Account:
· Prefi x · First Name 
· Middle Name · Last Name 
· Su�  x · Email
· Title · Phone Number
· Phone Number Extension · Cell Phone Number 
· Fax Number · Division
· Company Name · Linkedin Url 
· Twitter Handle · Facebook Url 
· Pinterest Url · Website Url

  Default Shipping Address:
· Street Address 1 · Street Address 2 
· City · Country 
· State · Zip

Location Manager Product Localization:

   Commonly used location manager fi elds: 
· Location Name · Street Address 
· Suite/Unit Address · City 
· State · Zip
· Location Url · Location Phone Number 

  Location Manager is not limited to what is shown: it can be customized to contain any fi elds 
  of content that will be used across templates and to manage the content in a central source.

Note: Unless othewise noted, text-based template variables pulling information from location manager are set as required and uneditable 
in the template. Common exceptions: business cards variables, second line of street address (may not be required).
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STEP 6: PACKAGING FILE FOR HAND-OFF
Once you are ready to supply your fi les, include all images and fonts. Ensure all images used are linked in the fi le and there are 
no missing fonts.

Creating a Package of the InDesign or Illustrator fi le will ensure you are supplying all used graphics and fonts. If you are unsure 
how to create an InDesign or Illustrator Package, you can fi nd instructions within  Adobe’s help online. If supplying your page(s) in 
another fi le format be sure to supply all used images and fonts in appropriately labeled folders. Add any additional assets needed 
for customizable options within the template following the guidelines provided in the Image Size & Format section under Step 5: 
Defi ning Customization.

 The following are common best practices to properly supply native files:
· Clearly label all folders within package (ex. Assets, Fonts)

   · Supply all images at 100% scale
   · Supply all images expected to print with transparent background as a rastered 
    .png or vestor .eps fi le format with the background already removed.
   · Clearly label the annotated pdf (ex. name_size_markup.pdf)
   · Sample of data, if the template should have a .csv function
   · Sample of all possible layout versions, if template has non-required 
    variable content (ex. business cards)
   · Remove all unused swatches from the fi le
   · Set up all swatches of linked vector artwork to match the way the document 
    is expected to print. (ex. artwork without spots if printing cmyk)

Zip the InDesign Package folder and upload to our ftp. Your CXA & Sales Rep will be notifi ed when fi les are uploaded to the ftp.


